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ANSI/ASHRAE Standard 

Building Automation and Control Networks 

BACnet/IP Driver 
 Supported version TOP Design Studio V1.4.3.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

1. System configuration Page 2 

 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

Please refer to this section and select the appropriate system. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

When changing external device settings, refer to this section  

and set identical TOP communication settings. 

4. Supported addresses Page 10 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “BACnet/IP” is as follows. 

 

Series 
Communication 

method 
System setting Cable 

Building Automation and Control Networks 

BACnet-IP 

Ethernet 

(UDP) 

3. TOP communication 

setting  
Twisted pair cable*Note 1) 

*Note 1) Twisted pair cable 

- Refer to STP (Shielded Twisted Pair Cable) or UTP (Unshielded Twisted Pair Cable) Category 3, 4, 5. 

- Depending on the network configuration, you can connect to components such as the hub and transceiver, and in this case, use a 

direct cable. 

 

 

■ Connectable configuration 

 

ㆍ1:1 connection (one TOP and one external device) connection 

 

 

 

1 : N connection (one TOP and multiple external devices) connection 

 

 

 

N : 1 connection (N TOPs and one external device) connection 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 

 

 
 

 

 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “OTHERS Manufacture”. 

PLC Select the external device to be connected to the TOP. 
 

Model Interface Protocol 

BACnet/IP Ethernet BACnet/IP 
 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 



 

 External device connection manual for TOP Design Studio 4 / 16 

3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project properties > TOP settings] → [Project option > Check “Use HMI settings” > Edit > Ethernet ] 

– Set the TOP communication interface in TOP Design Studio. 
 

 

 

 

 

Items TOP External device Remarks 

IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

Items Description 

IP Address Set an IP address to be used by the TOP to use over the network. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
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(2) Communication option setting 

■ [ Project > Project properties > PLC settings > ETHERNET(1) > “PLC1: BACnet/IP”] 

– BACnet/IP. Set the options of the communication driver in TOP Design Studio 

 
* The above settings are examples recommended by the company. 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select “BACnet/IP.” 

IP Enter the IP address of the external device.  

Ethernet Protocol TOP – Select “UDP” Ethernet protocol between external devices. Fixed 

Port Enter the Ethernet communication port number of the external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Who-Is Select whether to use Who-Is service of BACnet/IP protocol.  

Device ID Enter the Device ID (Instance No.) of the external device. (Set when using Who-Is)  

HMI Port Set the TOP Ethernet port number. (Set when using Who-Is)  

Import Address Register the address to be used for drawing. Refer to “4. Supported 

addresses” 
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen.  

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Ethernet ] 
 

 

 

Items TOP External device Remarks 

IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

 

Items Description 

IP Address Set an IP address to be used by the TOP to use over the network. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
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 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

 
* The above settings are examples recommended by the company. 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select “BACnet/IP.” 

IP Enter the IP address of the external device.  

Ethernet Protocol TOP – Select “UDP” Ethernet protocol between external devices. Fixed 

Port Enter the Ethernet communication port number of the external device.  

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Who-Is Select whether to use Who-Is service of BACnet/IP protocol.  

Device ID Enter the Device ID (Instance No.) of the external device. (Set when using Who-Is)  

HMI Port Set the TOP Ethernet port number. (Set when using Who-Is)  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and an external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check whether the port (ETH1/ETH2) settings you want to use are the same as those of the external devices in [Control panel > 

Ethernet]. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

External device CPU name OK NG 

 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

Check address range  

OK NG 

4. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. Supported addresses 

 This chapter describes how to register objects of BACnet devices in TOP Design Studio. 

 

※ Precautions when registering an address 
 

 This function is to register the object properties of the BACnet device as a variable address in TOP Design Studio. 
 

1. When importing by communication, the PC running TOP Design Studio and the BACnet device must be connected to the same 

network. 

2. When importing by communication, the name of the address is registered as the contents of Description among the properties of 

the object. 

3. You cannot use “ ` “ characters in the name of the address. 

4, The description field of the address shows [Object type, Instance number, Properties]. 

Ex) If there is an Analog Input object whose instance number is 100 and Description is “AI_100”, it is registered as follows. 
 

Name Data type Description 

AI_100 REAL AI.00100.PresentValue 

 

5. Import by communication function registers only Present Value as an address amoung object’s properties. Other properties can 

be registered by entering the address name, object type, instance number and property with the “Add” button. 

 

 

 

 

■ How to use Import Address 
 

Step 1. Execute “Import Address” among PLC setting items in TOP Design Studio. 
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Step 2. Click the Import button to enter the IP and device ID (Instance No.) of the corresponding device, and then click the OK 

button. 
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■ Object and property supported by TOP Design Studio 
 

※ Character String data type supports up to 80 characters. 

   Character String data type supports ANSI X3.4 encoding method. 
 

OBJECT TYPE PROPERTY Remarks 

Analog Input 

(AI) 

ObjectIdentifier  

ObjectName   

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

UpdateInterval  

Units  

MinPresValue  

MaxPresValue  

Resolution  

COVIncrement  

TimeDelay  

NotificationClass  

HighLimit  

LowLimit  

Deadband  

LimitEnable  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Analog Output 

(AO) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

UpdateInterval  

Units  

MinPresValue  

MaxPresValue  

Resolution  

PriorityArray  

RelinquishDefault  

COVIncrement  

TimeDelay  

NotificationClass  

HighLimit  

LowLimit  
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OBJECT TYPE PROPERTY Remarks 

Deadband  

LimitEnable  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Analog Value 

(AV) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

StatusFlags  

EventState  

Reliablity  

OutOfService  

Units  

PriorityArray  

RelinquishDefault  

COVIncrement  

TimeDelay  

NotificationClass  

HighLimit  

LowLimit  

Deadband  

LimitEnable  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Binary Input 

(BI) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

Polarity  

InactiveText  

ActiveText  

ChangeOfStateTime  

ChangeOfStateCount  

TimeOfStateCountReset  

ElapsedActiveTime  

TimeOfActiveTimeReset  

TimeDelay  

NotificationClass  

AlarmValue  

EventEnable  
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OBJECT TYPE PROPERTY Remarks 

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Binary Output 

(BO) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

DeviceType  

StatusFlags  

EventState  

Reliablity  

OutOfService  

Polarity  

InactiveText  

ActiveText  

ChangeOfStateTime  

ChangeOfStateCount  

TimeOfStateCountReset  

ElapsedActiveTime  

TimeOfActiveTimeReset  

MinimumOffTime  

MinimumOnTime  

PriorityArray  

RelinquishDefault  

TimeDelay  

NotificationClass  

FeedbackValue  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Binary Value 

(BV) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

StatusFlags  

EventState  

Reliablity  

OutOfService  

InactiveText  

ActiveText  

ChangeOfStateTime  

ChangeOfStateCount   

TimeOfStateCountReset  

ElapsedActiveTime  

TimeOfActiveTimeReset  

MinimumOffTime  

MinimumOnTime  

PriorityArray  
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OBJECT TYPE PROPERTY Remarks 

RelinquishDefault  

TimeDelay  

NotificationClass  

AlarmValue  

EventEnable  

AckedTransition  

NotifyType  

EventTimeStamps  

ProfileName  

Calendar 

(CD) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

DateList  

Command 

(CM) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

InProcess  

AllWritesSuccessful  

Divice 

(DV) 

ObjectIdentifier  

ObjectName  

ObjectType  

SystemStatus  

VendorName  

VendorId  

ModelName  

FirmwareRevision  

ApplicationSoftwareVersion  

ProtocolVersion  

ProtocolRevision  

MaxAPDUlengthAccepted  

SegmentationSupported  

ApduTimeout  

NumberOfAPDUretries  

DataBaseRevision  

MaxSegmentsAccepted  

DaylightSavingsStatus  

ApduSegmentTimeout  

BackupFailureTimeout  

Event Enrollment 

(ER) 

ObjectIdentifier  

ObjectName  

ObjectType  

Description  

EventType  

NotifyType  

EventParameter  

ObjectPropertyReference  

EventState  

EventEnable  

AckedTransitions  

NotificationClass  

Recipient  
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OBJECT TYPE PROPERTY Remarks 

ProcessIdentifier  

Priority  

IssueConfirmedNotification  

File 

(FI) 

ObjectIdentifier  

ObjectName  

ObjectType  

FileType  

FileSize  

Archive  

ReadOnly  

Group 

(GR) 

ObjectIdentifier  

ObjectName  

ObjectType  

Description  

ListOfGoupMembers  

Loop 

(LP) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

Description  

Life Safety Point 

(LSP) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

TrackingValue  

EventState  

Reliability  

OutOfService  

Mode  

Silenced  

Life Safety Zone 

(LSZ) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

TrackingValue  

EventState  

Reliability  

OutOfService  

Mode  

Silenced  

Multi State Input 

(MI) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

EventState  

OutOfService  

Reliability  

NumberofStates  

TimeDelay  

NotifyClass  

NotifyType  

ProfileName  
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OBJECT TYPE PROPERTY Remarks 

Multi State Output 

(MO) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

EventState  

OutOfService  

Reliability  

NumberofStates  

TimeDelay  

NotifyClass  

NotifyType  

ProfileName  

Multi State Value 

(MV) 

ObjectIdentifier  

ObjectName  

ObjectType  

PresentValue  

EventState  

OutOfService  

Reliability  

NumberofStates  

TimeDelay  

NotifyClass  

NotifyType  

ProfileName  

Notification Class 

(NC) 

ObjectIdentifier  

ObjectName  

ObjectType  

NotifyClass  

Program 

(PG) 

ObjectIdentifier  

ObjectName  

ObjectType  

Description  

ProgramState  

ProgramChange  

ReasonForHalt  

DescriptionOfHalt  

ProgramLocation  

InstanceOf  

StatusFlags  

Reliability  

OutOfService  

Schedule 

(SC) 

ObjectIdentifier  

ObjectName  

ObjectType  

PriorityForWriting  

Trend Log 

(TL) 

ObjectIdentifier  

ObjectName  

ObjectType  

Enable  

StopWhenFull  

BufferSize  

RecordCount  

TotalRecordCount  
 


